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4
Komande za izmene

Srce svakog CAD sistema jeste mogu}nost izmene i manipulisanja postoje}om geometrijom. 
Isti slu~aj je i sa AutoCAD-om. Komande za izmene znatno olak{avaju posao dizajniranja. Ovde
}emo se usredsrediti na osnovne AutoCAD-ove komande za izmene, kao {to su Array, Break,
Chamfer, Copy, Extend, Fillet, Lengthen, Mirror, Move, Offset, Rotate, Scale i Stretch. Brojna,
mala, ve`banja prate svaku komandu da bi podvukla va`nost njenog kori{}enja.

Metodi aktiviranja komandi za izmene
Komande za izmene mo`ete na}i u padaju}em meniju Modify, prikazanom na slici 4.1. Mo`ete
ih koristiti i sa palete Modify, prikazane na slici 4.2.

SLIKA 4.1 SLIKA 4.2
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Tako|e, sve komande za izmene mo`ete uneti i direktno sa tastature, koriste}i ili celu komandu,
ili njenu skra}enicu, kao u slede}em primeru.

Unesite E za komandu ERASE.

Unesite M za komandu MOVE.

Kompletna lista komandi i njihovih skra}enica nalazi se u tabeli 1.2 u Poglavlju 1.

Stvaranje pravougaonih nizova pomo}u okvira za
dijalog Array

Na~in 1
Stvaranjem pravougaonih nizova pomo}u okvira za dijalog Array mo`ete vi{estruko kopirati
objekte u pravougaone ili polarne (kru`ne) nizove. Kada pravite pravougaoni niz, program 
zahteva da unesete broj redova i kolona niza. Red (row) je grupa objekata koji se kopiraju 
vertikalno u pozitivnom ili negativnom smeru. Kolona (column) je grupa objekata koji se 
kopiraju horizontalno, tako|e u pozitivnom ili negativnom smeru.

PROBAJTE!DDOtvorite crte` 04_Array Rectangular1. Pretpostavimo da je objekat sa slike 4.3 
potrebno kopirati u pavougaoni niz koji se sastoji od tri reda i tri kolone. Potrebno je da rastojanje
izme|u redova bude 0.50 jedinica, a izme|u kolona 1.25 jedinica. Rezultat je prikazan na slici 4.4.

SLIKA 4.3 SLIKA 4.4

Ako kliknete na stavku Array u padaju}em meniju Modify (slika 4.5), otvori}e se okvir za dijalog
Array. Unesite slede}a pode{avanja. Na po~etku, u gornjem levom uglu okvira za dijalog treba da
je izabrana opcija Rectangular Array. Unesite 4 za broj redova i 3 za broj kolona. Za rastojanje
izme|u redova (Row offset) unesite vrednost od 1 jedinice, a za rastojanje izme|u kolona
(Column offset) 2 jedinice. Posle toga kliknite na dugme Select Objects u gornjem desnom uglu
okvira za dijalog. Sada, po{to ste ponovo u ekranu za crtanje, treba da izaberete objekte od kojih
}e se praviti pravougaoni niz. Izaberite pravougaonik i dve dijagonale ovog pravougaonika. 
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Kada posle ovog izbora pritisnete taster ENTER, vrati}ete se u okvir za dijalog Array (slika 4.6).
[ablon u polju za pregled sada je promenjen i ima tri reda i tri kolone. Primetite da je aktivno
dugme Preview u donjem desnom uglu okvira za dijalog. Ako kliknete na njega, vide}ete kako bi
niz izgledao u crte`u. Na slici 4.7 prikazan je izgled ovoga niza; ako ste zadovoljni ovim 
izgledom, mo`ete izabrati dugme Accept, a ako niste, izaberite komandno dugme Modify i vratite
se u okvir za dijalog Array da izvr{ite promene koje `elite. Komandno dugme Cancel otkaza}e
celu operaciju i vrati}ete se na po~etak.

SLIKA 4.5 SLIKA 4.6

SLIKA 4.7
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S A V E T

Kada se prave nizovi od pravougaonih objekata, donji levi ugao objekta je referentna ta~ka. U odnosu na
ovu referentnu ta~ku ra~unaju se rastojanja izme|u redova i izme|u kolona. Prilikom odre|ivanja ovih 
rastojanja treba uzeti u obzir i dimenzije objekta. Naime, rastojanje izme|u dva reda ra~una se izme|u dve
referentne ta~ke, dva uzastopna objekta koji su jedan ispod drugog. Na slici 4.4, rastojanje izme|u dva reda
je 1.00. To je, u stvari, rastojanje izme|u dve referentne ta~ke ra~unaju}i i dimenzije objekta, a pravo 
rastojanje izme|u dva reda je 0.50. Me|utim, rastojanje koje se unosi u odgovaraju}e polje okvira za 
dijalog upravo je ovo rastojanje izme|u dve referentne ta~ke. Isto je i za rastojanja izme|u kolona, unosi se
vrednost od 2.00 jedinice, rastojanje izme|u dve referentne ta~ke (du`ina objekta 0.75 i rastojanje 1.25).

Stvaranje pravougaonih nizova

Na~in 2
Niz prikazan na slici 4.7 dobijen je sa pozitivnim rastojanjima izme|u redova i kolona; objekti
su kopirani gore i desno od referentnog objekta. Ako se unesu negativna rastojanja, objekti }e biti
kopirani dole i levo od referentnog objekta (videti sliku 4.8).

SLIKA 4.8

PROBAJTE!DDOtvorite crte` 04_Array Rectangular2. Sledite prikaz na slici 4.8 i donji niz zahteva
za unos da biste kopirali objekte u niz.

Aktivirajte okvir za dijalog Array kao na slici 4.9. Dok ste u modu Rectangular array, podesite broj
redova na 3, a broj kolona na 2. Po{to }e smer niza biti levo i dole od originalnog objekta, 
vrednosti rastojanja za kolone i redove bi}e negativne. Kada zavr{ite, pregledajte niz; ako su 
rezultati sli~ni kao na slici 4.8, kliknite dugme OK da biste stvorili pravougaoni niz.

178



179

Komande za izmene POGLAVLJE 4

SLIKA 4.8

PROBAJTE!DDOtvorite crte` 04_Array I-Beam i napravite pravougaoni niz koji se sastoji od ~etiri
reda i pet kolona. Neka razmak izme|u redova i kolona bude 20'. Na kraju mo`ete dodati kote.
Rezultat je prikazan na slici 4.10.

SLIKA 4.10

N A P O M E N A

Greda I-profila i okvir pretvoreni su u objekat tipa bloka. Referentna ta~ka za umetanje bloka je u centru 
okvira. Zbog ovoga }e se rastojanja izme|u redova i kolona niza meriti od centara blokova - referentnih ta~aka.

Stvaranje polarnih nizova pomo}u okvira za dijalog Array
Polarni (kru`ni) nizovi omogu}avaju stvaranje vi{estrukih kopija objekata po polarnom ili
kru`nom {ablonu.



AutoCAD
®

2004 za in`enjere ma{instva

PROBAJTE!DDOtvorite crte` 04_Array Polar1, kao na slici 4.11, i otvorite okvir za dijalog Array.
Kliknite na dugme Select objects pri vrhu okvira za dijalog i izaberite pravougaonik sa slike 4.12
da biste od njega napravili niz. Za centralnu ta~ku niza izaberite centar kru`nice "C" (pomo}u
opcije Center OSNAP). U polje za editovanje Total number of items unesite 8. Ovako odre|ujete
ukupan broj kopiranih objekata. U polje Angle to fit unesite 360 (stepeni) - ugao koji }e polarni
niz zahvatati. Potvrdite opciju Rotate items as copied - objekti }e se rotirati prilikom kopiranja.
Okvir za dijalog Array treba da izgleda kao na slici 4.13. Klikom na dugme Preview mo`ete 
videti kako }e ovaj niz izgledati na crte`u (slika 4.14).

SLIKA 4.11 SLIKA 4.12

SLIKA 4.13
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SLIKA 4.14

PROBAJTE!DDOtvorite crte` 04_Array Polar2. Da biste kopirali pravougaoni ili kvadratni objekat
u polarni niz bez rotiranja objekata, prvo pretvorite ovaj objekat u blok sa ta~kom umetanja u
centru objekta (ovo }e biti detaljno obja{njeno u Poglavlju 16). Ovako }e svi kvadrati biti na 
jednakom rastojanju od njihovog zajedni~kog centra. Da biste izvr{ili operaciju stvaranja niza,
unesite slede}a pode{avanja u okvir za dijalog Array, prikazan na slici 4.15.

SLIKA 4.15
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Va{i rezultati trebalo bi da li~e na prikaz na slici 4.16

SLIKA 4.16

Kopiranje rupa za zavrtnje u niz - na~in #1
U prethodnom primeru videli smo kako je lako koristiti okvir za dijalog Array. [ta ako se objekti
kopiraju samo po delu obima kruga, kao {to je slu~aj sa rupama za zavrtnje na slici 4.17? Okvir za
dijalog Array mo`e se koristiti za kopiranje rupa pod uglom od 40 stepeni. Sledite niz zahteva za
unos da biste izvr{ili operaciju prikazanu na slici 4.17.

SLIKA 4.17

PROBAJTE!DDOtvorite crte` 04_Bolthole2. Koristite okvir za dijalog Array, izaberite krug i osnu
liniju, a zatim kopirajte izabrane objekte pod uglom od 40 stepeni koriste}i slede}e informacije
unete u okvir za dijalog. Metod ''Angle to fill & Angle between items'' treba da bude izabran u
okviru za dijalog, prikazanom na slici 4.18. Ovo }e aktivirati odgovaraju}a polja i dozvoliti vam
da unesete ta~ne informacije (kao na slici 4.18).

Blok
Ta~ka umetanja

(B) (A)
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SLIKA 4.18

Rezultat je prikazan na slici 4.20. Ovaj metod odre|ivanja polo`aja rupa za zavrtnje, prikazuje
kako mo`ete kontrolisati broj nacrtanih rupa odre|uju}i ceo ugao za ispunjavanje i ugao izme|u
objekata koji se kopiraju. Negativna vrednost uneta je u polje za izbor ''Angle to fill'' da bi polarni
niz bio nacrtan u smeru kazaljke na satu.

SLIKA 4.19                                            SLIKA 4.20
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Kopiranje rupa za zavrtnje u niz - na~in 2
Crte` na slici 4.21 sli~an je objektu prikazanom u odeljku ''Kopiranje rupa za zavrtnje u 
niz - na~in 1'' sa prethodnih slika. Postoji jo{ jedna grupa krugova koji su kopirani pod uglom od
20 stepeni pomo}u okvira za dijalog Array.

SLIKA 4.21

PROBAJTE!DDOtvorite crte` 04_Bolthole3. Koristitie okvir za dijalog Array, izaberite krug i osnu
liniju, prikazane na slici 4.23, kao objekte koji se kopiraju u niz i izaberite centar kruga kao 
centar niza. Kopirajte izabrane objekte pod uglom od 20 stepeni koriste}i slede}e informacije
unete u okvir za dijalog. Uverite se ponovo da je metod ''Angle to fill & Angle between items''
izabran u okviru za dijalog, prikazanom na slici 4.22. Ovo }e aktivirati odgovaraju}a polja i
dozvoliti vam da unesete ta~ne informacije

SLIKA 4.22
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Po{to je smer rotacije objekata pozitivan matemati~ki smer, sve vrednosti za uglove su pozitivne
(videti sliku 4.22). Rezultati su prikazani na slici 4.24.

SLIKA 4.23 SLIKA 4.24

Komanda BREAK

Komanda BREAK koristi se za brisanje nekog dela objekta. Izaberite ovu komandu na jedan od
slede}ih na~ina:

sa palete sa alatkama Modify,

sa padaju}eg menija (Modify>Break),

pomo}u tastature (BR ili BREAK). 

Koristite slede}i niz zahteva za unos i sliku 4.25 da biste videli kako ova komanda funkcioni{e.

PROBAJTE!DDOtvorite crte` 04_Break1. Isklju~ite mod OSNAP pre otpo~injanja ovog ve`banja.
Koristite slede}i niz zahteva za unos i ilustracije da biste prekinuli objekat.

Command: BR (skra}enica za BREAK)
Select objects: (Izaberite liniju pored "A" sa slike 4.25)
Specify second break point or ŠFirst point¹: (Izaberite liniju pored "B" sa slike 4.25)

PROBAJTE!DDOtvorite crte` 04_Break2. Koristite opciju First komande BREAK zajedno sa 
opcijama OSNAP da biste prekinuli objekat. Opcija OSNAP privremeno prekida teku}u komandu
i dozvoljava vam da izaberete objekat koji }ete prekinuti zajedno sa razli~itim ta~kama koje
odre|uju ta~no mesto prekida. Slede}i niz zahteva za unos i slika 4.26 ilustruju kori{}enje opcije
First komande BREAK.
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Command: BR (skra}enica za BREAK)
Select objects: (Izaberite liniju prikazanu na slici 4.26)
Specify second break point or ŠFirst point¹: F (za First)
Specify first break point: Int
od (Izaberite presek dve linije pored "A")
Specify second break point: End
od (Izaberite krajnju ta~ku linije pored "B")

SLIKA 4.25 SLIKA 4.26

PROBAJTE!DDOtvorite crte` 04_Break3. Prekidanje krugova se uvek vr{i u smeru suprotnom od
kretanja kazaljki na satu. Za prekidanje krugova, prou~ite slede}i niz zahteva za unos i sliku 4.27.

Command: BR (skra}enica za BREAK)
Select objects: (Izaberite krug prikazan na slici 4.27)
Specify second break point or ŠFirst point¹: F (za First)
Specify first break point: (Izaberite ta~ku "A" na bilo kom krugu na slici 4.27)
Specify second break point: End od (Izaberite ta~ku "B" na bilo kom krugu na slici 4.27)

SLIKA 4.27

Izaberite
krug

(A)

(A)

(B)

(B)

Izaberite liniju

(A)
(B)

(A)

(B)
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Opcija Break at point
Izabrani predmet mo`ete prekinuti i u izabranoj ta~ki. Na slici 4.28 na levoj strani, ozna~ena je
linija da bi se prikazalo da je to jedan, neprekidan predmet. Izbor opcije ''Break at point'' sa palete
Modify pokre}e slede}i komandni unos:

Command: BR (za BREAK)
Select object: (Izaberite liniju kao na levoj strani slike 4.28)
Specify second break point or ŠFirst point¹: F (Za First point)
Specify first break point: MID
od (Izaberite sredju ta~ku linije na slici 4.28)
Specify second break point:ª (Za prethodnu ta~ku)

Rezultat je prikazan na slici 4.28 na desnoj strani.Vidi se da je predmet prekinut u sredi{njoj ta~ki.

SLIKA 4.28

Komanda CHAMFER
Obaranje ivica (chamfer) predstavlja uobi~ajeni na~in zavr{ne obrade o{trih ivica predmeta.
Komanda CHAMFER pravi kosu, nagnutu povr{inu, prelaz izme|u dve normalne povr{ine.
Rastojanja koja se javljaju kao zahtevi za unos odre|uju koliko }e daleko od o{tre ivice biti
postavljena kosa povr{ina. Na slici 4.29 prikazan je predmet kome su oborene gornje ivice.

Komanda CHAMFER napravljena je da bi se nacrtale oborene ivice predmeta. Izaberite ovu
komandu na jedan od slede}ih na~ina:

sa palete sa alatkama Modify,

sa padaju}eg menija (Modify>Chamfer),

pomo}u tastature (CHA ili CHAMFER). 
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Nova povr{ina, dobijena komandom CHAMFER, je pod nekim o{trim uglom u odnosu na pravac
povr{ina predmeta (obi~no pod uglom od 45 stepeni - videti sliku 4.30). Ugao pod kojim je
postavljena ova kosa povr{ina mo`e se uneti preko komandne linije, ali se on obi~no odre|uje
posredno preko rastojanja ivica nove povr{ine od o{tre, prvobitne ivice.

PROBAJTE!DDOtvorite crte` 04_Chamfer Distances. U primeru na slici 4.30 prikazano je obaranje
ivica pod uglom od 45 stepeni. Ako su oba rastojanja koja se defini{u pri obaranju ivica ista, ugao
obaranja ivica bi}e uvek 45 stepeni. Prou~ite ilustraciju na slici 4.30 i slede}i niz zahteva za unos.

Command: CHA (skra}enica za CHAMFER)
(TRIM mode) Current chamfer Dist 1 = 0.5000, Dist2 = 0.5000
Select first line or ŠPolyline/Distance/Angle/Trim/Method/mUltiple¹: D (za Distance)
Specify first chamfer distance <0.5000>: 0.15
Specify second chamfer distance <0.1500> (Pritisnite taster ENTER da prihvatite
ponu|enu vrednost)
Select first line or ŠPolyline/Distance/Angle/Trim/Method/mUltiple¹: (Izaberite liniju
pored "A")
Select second line: (Izaberite liniju pored "B")

SLIKA 4.29 SLIKA 4.30

PROBAJTE!DDOtvorite crte` 04_Chamfer Angle. Slika 4.31 prikazuje upotrebu komande CHAMFER
kori{}enjem opcije Angle. Ova opcija zahteva uno{enje rastojanja jedne ivice i ugla pod kojim }e biti
kosa povr{ina. Ova opcija omogu}uje obaranje ivica pod uglom razli~itim od 45 stepeni.

Command: CHA (skra}enica za CHAMFER)
(TRIM mode) Current chamfer Dist 1 = 0.5000, Dist2 = 0.5000
Select first line or ŠPolyline/Distance/Angle/Trim/Method/mUltiple¹: A (za Angle)
Specify chamfer length on the first line <0.1500>: 0.15
Specify chamfer angle from the first line <60>: 60
Select first line or ŠPolyline/Distance/Angle/Trim/Method/mUltiuple¹: (Izaberite liniju
pored "A")
Select second line: (Izaberite liniju pored "B")
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SLIKA 4.31

PROBAJTE!DDOtvorite crte` 04_Chamfer Corner. Za linije koje se ne seku mo`ete koristiti 
komandu CHAMFER da pove`ete obe linije. Oba rastojanja komande CHAMFER su za ovu opciju
pode{ena na 0 (videti sliku 4.32).

Command: CHA (skra}enica za CHAMFER)
(TRIM mode) Current chamfer Dist 1 = 0.5000, Dist2 = 0.5000
Select first line or ŠPolyline/Distance/Angle/Trim/Method/mUltiple¹: D (za Distance)
Specify first chamfer distance <0.5000>: 0
Specify second chamfer distance <0.0000> (Pritisnite taster ENTER da prihvatite
ponu|enu vrednost)
Select first line or ŠPolyline/Distance/Angle/Trim/Method/mUltiple¹: (Izaberite liniju
pored "A")
Select second line: (Izaberite liniju pored "B")

PROBAJTE!DDOtvorite crte` 04_Chamfer Pline. Po{to se polilinija sastoji od vi{e segmenata koji
zajedno predstavljaju jedan objekat, kori{}enje komande CHAMFER, sa opcijom Polyline, daje
zako{enja po celoj poliliniji. Pogledajte sliku 4.33.

Command: CHA (skra}enica za CHAMFER)
(TRIM mode) Current chamfer Dist 1 = 0.00, Dist2 = 0.00
Select first line or ŠPolyline/Distance/Angle/Trim/Method/mUltiple¹: D (za Distance)
Enter first chamfer distance <0.00>: 0.50
Enter second chamfer distance <0.50> (Pritisnite taster ENTER da prihvatite ponu|enu
vrednost)
Select first line or ŠPolyline/Distance/Angle/Trim/Method/mUltiple¹: P (za Polyline)
Select 2D Polyline: (Izaberite poliliniju sa slike 4.34)

N A P O M E N A

Opcija Multiple komande Chamfer dozvoljava vam da oborite ivice koje imaju ista pode{avanja kao i u
prethodnoj komandi Chamfer, bez izlaska i ponovnog ulaska u komandu.

PROBAJTE!DDOtvorite crte` 04_Chamfer No-Trim. Komanda CHAMFER podr`ava opcije
Trim/No trim, omogu}avaju}i postavljanje zako{enja sa odsecanjem krajeva linija ili bez 
odsecanja, kao na slici 4.34. Sledite pa`ljivo naredni niz zahteva za unos da biste podesili opciju
No trim.
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Command: CHA (skra}enica za CHAMFER)
(TRIM mode) Current chamfer Dist 1 = 0.2000, Dist2 = 0.2000
Select first line or ŠPolyline/Distance/Angle/Trim/Method/mUltiple¹: T (za Trim)
Trim/No trim <Trim>: N (za No trim)
Polyline/Distance/Angle/Trim/Method/<Select first line> D (za Distance)
Enter first chamfer distance <0.00>: 1.00
Enter second chamfer distance <1.0000> (Pritisnite taster ENTER da prihvatite
ponu|enu vrednost)
Select first line or ŠPolyline/Distance/Angle/Trim/Method/mUltiple¹: P (za Polyline)
Select 2D Polyline: (Izaberite poliliniju pored "A")

SLIKA 4.32 SLIKA 4.33

Sve ivce su zako{ene bez odsecanja.

N A P O M E N A

Ponovo podesite opciju Trim/No trim komande CHAMFER na Trim. Ovo mo`ete uraditi direktno sa tastature
uno{enjem sistemske promenljive TRIMMODE i pode{avanjem njene vrednosti na 1 (On).

Command: TRIMMODE
Enter new value for TRIMMODE <0>: 1

SLIKA 4.34

Izaberite poliliniju

Rezultat

(A)

(B)
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PROBAJTE!DDOtvorite crte` 04_Chamfer Beam. Koriste}i ilustraciju na slici 4.35, sledite uputstva.
Unesite jednaka rastojanja od 0.25 jedinica za uglove "AB", "BC", "DE" i "EF". Za uglove "GH" i
"JK" unesite jednaka rastojanja od 0.50 jedinica. Zatim, unesite vrednost rastojanja za prvu ivicu od
1.00 jedinice, a za drugu od 0.50 jedinica. Prvo rastojanje primenite na liniju "L", a drugo na liniju
"H". Ponovite to na linijama "M" i "K".

SLIKA 4.35

Komanda COPY
Komanda COPY koristi se za umno`avanje objekta ili grupe objekata. Izaberite ovu komandu na
jedan od slede}ih na~ina:

sa palete sa alatkama Modify,

sa padaju}eg menija (Modify>Copy),

pomo}u tastature (CP ili COPY).

Na slici 4.36 izvr{en je izbor objekata za kopiranje kori{}enjem opcije Window. Ta~ka "C" je tzv.
bazna ta~ka za pomeranje. Ova ta~ka odre|uje za koju ta~ku }e se kursor vezati pri pomeranju
objekta koji se kopira. Ta~ka "D" je tzv. druga ta~ka za pomeranje i odre|uje mesto gde }e objekat
biti kopiran.

Command: CP (skra}enica za COPY)
Select objects: (Izaberite ta~ku pored "A")
Other corner: (Izaberite ta~ku pored "B")
Select objects: (Pritisnite taster ENTER da biste nastavili)
Specify base point or displacement or ŠMultiple¹: (Izaberite krajnju ta~ku ugla pored "C")
Specify second point of displacement or <use first point as displacement>: (Izaberite 

ta~ku pored "D")
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U okviru komande COPY mo`ete vr{iti i vi{estruko kopiranje. Slika 4.37 prikazuje vi{estruko
kopirane objekte kori{}enjem opcije Multiple. Slede}i niz zahteva za unos prikazuje kori{}enje
opcije Multiple komande COPY.

Command: CP (skra}enica za COPY)
Select objects: (Izaberite sve objekte koji ~ine predmet pored "A")
Select objects: (Pritisnite taster ENTER da biste nastavili)
Specify base point or displacement or ŠMultiple¹: M (za Multiple)
Specify base point: (Izaberite krajnju ta~ku ugla pored "A")
Specify second point of displacement or <use first point as displacement>: (Izaberite 

ta~ku pored "B")
Specify second point of displacement or <use first point as displacement>: (Izaberite 

ta~ku pored "C")
Specify second point of displacement or <use first point as displacement>: (Izaberite 

ta~ku pored "D")
Specify second point of displacement or <use first point as displacement>: (Izaberite 

ta~ku pored "E")
Specify second point of displacement or <use first point as displacement>: (Izaberite 

ta~ku pored "F")
Specify second point of displacement or <use first point as displacement>: (Pritisnite 

taster ENTER da iza|ete iz komande)

SLIKA 4.36  SLIKA 4.37

PROBAJTE!DDOtvorite crte` 04_Copy Multiple. Sledite niz zahteva za unos iz prethodnog
primera da biste vi{estruko kopirali tri rupe. Kao baznu ta~ku za kopiranje koristite ta~ku kod 
preseka "A". Zatim, kopirajte tri rupe kod preseka pored "B", "C", "D", "E", "F", "G", "H" i "J"
(videti sliku 4.38).
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SLIKA 4.38

Komanda EXPLODE
Komanda EXPLODE rastavlja slo`ene objekte, kao {to su polilinija, kota ili blok, na njihove 
sastavne delove. Izaberite ovu komandu na jedan od slede}ih na~ina:

sa palete sa alatkama Modify,

sa padaju}eg menija (Modify>Explode),

pomo}u tastature (X ili XPLODE). 

Na slici 4.39 prikazana je polilinija koja se smatra jedinstvenim objektom. Kori{}enje komande
EXPLODE razbija poliliniju na ~etiri individualna objekta - ~etiri linije.

Command: X (skra}enica za EXPLODE)
Select objects: (Izaberite poliliniju sa slike 4.39)
Select objects: (Pritisnite taster ENTER da izvr{ite operaciju EXPLODE)

SLIKA 4.39

Kote se sastoje od kotnih linija, pomo}nih kotnih linija, teksta kote i strelica. Svi su grupisani u
jedan objekat. Kote }e biti razmatrane u Poglavlju 11. Ako se komanda EXPLODE koristi za 
razbijanje kota, svi elementi koji sa~injavaju kotu posta}e nezavisni entiteti. Ovo nije
preporu~ljivo jer se gubi osnovna svrha kote. 

Polilinija
Pre komande EXPLODE - 1 objekat

Posle komande EXPLODE - 4 objekta
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Ako se objekat razvu~e komandom STRETCH, kota se vi{e ne mo`e a`urirati da bi pratila novu
dimenziju objekta. Tako|e, nije mogu}e menjati kotu pomo}u alatke Grips (ru~ice). Ru~ice }e
biti razmatrane u Poglavlju 7.

Command: X (skra}enica za EXPLODE)
Select objects: (Izaberite kotu sa slike 4.40)
Select objects: (Pritisnite taster ENTER da biste izvr{ili komandu EXPLODE)

Kori{}enje komande EXPLODE na blokovima pretvara blok od jednog objekta u niz elementarnih
objekata od kojih je blok napravljen. Tako od bloka dobijamo linije, krugove itd. Ako se u okviru
nekog bloka nalazi jo{ jedan blok, potrebno je jo{ jednom izvr{iti komandu EXPLODE, da bi se
i taj blok razbio na elemente.

Command: X (skra}enica za EXPLODE)
Select objects: (Izaberite blok prikazan na slici 4.41)
Select objects: (Pritisnite taster ENTER da biste izvr{ili komandu EXPLODE)

SLIKA 4.40 SLIKA 4.41

PROBAJTE!DDOtvorite crte` 04_Explode. Komandu EXPLODE upotrebite za razbijanje blokova ~iji
je izgled izmenjen komandom Scale. Na slici 4.42 prikazani su objekti istog bloka promenjeni
razli~itim faktorima razmere.

SLIKA 4.42

Originalni
objekat

X Scale=1
Y Scale=1

X Scale=2
Y Scale=0.5

X Scale=0.5
Y Scale=2

Blok
Pre komande EXPLODE - 1 objekat

Posle komande EXPLODE - 15 objekataKota
Pre komande EXPLODE - 1 objekat

Posle komande EXPLODE - 7 objekata
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Komanda EXTEND
Komanda EXTEND koristi se za produ`avanje objekata do odre|enog grani~nog objekta. Izaberite
ovu komandu na jedan od slede}ih na~ina:

sa palete sa alatkama Modify,

sa padaju}eg menija (Modify>Extend),

pomo}u tastature (EX ili EXTEND). 

Izaberite veliki krug "A" na slici 4.43 kao grani~ni objekat. Kada pritisnete taster ENTER da 
nastavite komandu, izaberite luk pored "B", liniju pored "C" i luk pored "D" da biste ove
objekte produ`ili do kruga. Ako izaberete pogre{an kraj objekta, mo`ete koristiti opciju Undo u
okviru komande da biste ponovo izabrali pravi kraj objekta.

PROBAJTE!DDOtvorite crte` 04_Extend1. Sledite donju ilustraciju i niz zahteva za unos.

Command: EX (skra}enica za EXTEND)
Current settings: Projection=UCS Edge=None
Select boundary edges…
Select objects: (Izaberite veliki krug pored "A")
Select objects: (Pritisnite taster ENTER da biste nastavili)
Select object to extend or shift-select to trim or ŠProject/Edge/Undo¹: (Izaberite luk pored "B")
Select object to extend or shift-select to trim or ŠProject/Edge/Undo¹: (Izaberite liniju pored "C")
Select object to extend or shift-select to trim or ŠProject/Edge/Undo¹: (Izaberite luk pored "D")
Select object to extend or shift-select to trim or ŠProject/Edge/Undo¹: (Pritisnite taster ENTER da 

iza|ete iz komande)

S A V E T

Grani~ne ivice mo`ete izabrati na jo{ jedan na~in, ako pritisnete taster ENTER kao odgovor na zahtev za
unos "Select objects". Na ovaj na~in stvaraju se grani~ne ivice od svih objekata u crte`u. Me|utim, ako koris-
tite ovaj na~in izbora, grani~ne ivice ne}e biti istaknute.

SLIKA 4.43
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PROBAJTE!DDOtvorite crte` 04_Extend2. Da biste produ`ili vi{e objekata, kao {to je slu~aj sa
{esnaest segmenata linije na slici 4.44, izaberite liniju pored "A" kao grani~nu ivicu i koristite
mod Fence za izbor linija za produ`avanje. Ako nacrtate liniju od "B" do "C" kao liniju opcije
Fence, izabra}ete svih {esnaest linija za produ`enje.

Command: EX (skra}enica za EXTEND)
Current settings: Projection=UCS Edge=None
Select boundary edges…
Select objects: (Izaberite liniju pored "A" na slici 4.44)
Select objects: (Pritisnite taster ENTER da biste nastavili)
Select object to extend or shift-select to trim or ŠProject/Edge/Undo¹: F (za Fence)
First fence point: (Izaberite ta~ku pored "B")
Specify endpoint of line or ŠUndo¹: (Izaberite ta~ku pored "C")
Specify endpoint of line or ŠUndo¹: (Pritisnite taster ENTER da iza|ete iz opcije Fence 

i izvr{ite operaciju produ`avanja)
Select object to extend or shift-select to trim or ŠProject/Edge/Undo¹: (Pritisnite taster 

ENTER da napustite komandu)

SLIKA 4.44

PROBAJTE!DDOtvorite crte` 04_Extend3. Pomo}u komande EXTEND mogu}e je produ`iti 
objekte do prividnog preseka sa grani~nom ivicom. Slede}i niz zahteva za unos i slika 4.45 
ilustruju kori{}enje ove opcije komande EXTEND.
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Command: EX (skra}enica za EXTEND)
Current settings: Projection=UCS Edge=None
Select boundary edges…
Select objects: (Izaberite liniju "A")
Select objects: (Pritisnite taster ENTER da biste nastavili)
Select object to extend or shift-select to trim or ŠProject/Edge/Undo¹: E (za Edge)
First fence point: (Izaberite ta~ku pored "B")
Enter an implied edge extension mode ŠExtend/No extend¹ <No extend>: E

(za produ`avanje ivice)
Select object to extend or shift-select to trim or ŠProject/Edge/Undo¹: (Izaberite liniju "B")

Ostale linije koje `elite da produ`ite mo`ete izabrati pojedina~no ili kori{}enjem opcije izbora
Fence. Kada se sve linije produ`e, pritisnite taster ENTER da napustite komandu.

SLIKA 4.45

N A P O M E N A

Ponovo podesite opciju za produ`avanje grani~nih ivica komande EXTEND na No Extend. Ovo mo`ete 
uraditi i pomo}u sistemske promenljive EDGEMODE. Potrebno je da promenite njenu vrednost ponovo na
nulu.

Command: EDGEMODE
Enter new value for EDGEMODE <1>: 0

S A V E T

Iz komande EXTEND mo`ete lako da se prebacite u komandu TRIM tako {to }ete dr`ati pritisnut taster SHIFT
i slediti naredni niz zahteva za unos:

Select object to extend or shift-select to trim or ŠProject/Edge/Undo¹: (Da biste aktivirali 
komandu TRIM, dr`ite pritisnut taster SHIFT dok birate objekte.)

PROBAJTE!DDOtvorite crte` 04_Extend Pipe. Unesite komandu EXTEND i pritisnite taster ENTER
kada se pojavi zahtev za unos "Select objects". Ovo }e izabrati sve objekte kao grani~ne ivice. Kao
objekte koje treba da produ`ite, izaberite krajeve svih `utih linija koje predstavljaju cevi. Linije }e
se produ`iti do preseka sa najbli`im spojem cevi. Zavr{en crte` treba da izgleda kao na slici 4.46.
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SLIKA 4.46

Komanda FILLET
Tehnolo{ki zahtevi za izradu raznih delova mogu biti razli~iti. Za neke delove zahtevaju se 
polirane povr{ine i o{tre ivice. Izrada drugih delova, naprotiv, zahteva zaobljene ivice.
Zaobljavanje ivica mo`e biti potrebno iz estetskih ili tehnolo{kih razloga. Na slici 4.47 prikazan je
predmet sa zaobljenim ivicama pored "A" i "B". Ivice kovanih i livenih delova su uvek zaobljene
iz tehnolo{kih razloga. Na delovima koji imaju mnogo zaobljenih ivica sa istim radijusom ne
ozna~ava se svaka zaobljena ivica, ve} se napomenom nazna~i koliko je zaobljenje.

SLIKA 4.47

U AutoCAD-u postoji komanda FILLET koja omogu}uje izbor ivica za zaobljavanje i radijusa
zaobljenja. Krajevi linija se automatski odsecaju posle zaobljavanja. Izaberite ovu komandu na
jedan od slede}ih na~ina:
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sa palete sa alatkama Modify,

sa padaju}eg menija (Modify>Fillet),

pomo}u tastature (F ili FILLET).

Na slici 4.48 prikazani su primeri kori{}enja komande FILLET. Kada je potrebno vi{e puta 
koristiti ovu komandu, to je mogu}e pomo}u komande MULTIPLE. Ova komanda automatski
ponavlja `eljenu komandu, u ovom slu~aju FILLET. Kada `elite da iza|ete iz komande 
MULTIPLE, pritisnite taster ESC.

PROBAJTE!DDOtvorite crte` 04_Fillet. Sledite niz zahteva za unos i prikaz na slici 4.48 da biste
koristili komande MULTIPLE i FILLET.

Command: F (For FILLET)
Current settings: Mode = TRIM, Radius = 0.0000
Select first object or ŠPolyline/Radius/Trim/mUltiple¹: R (Za Radius)
Specify fillet radius <0.0000>: 0.25
Select first object or ŠPolyline/Radius/Trim/mUltiple¹: U (Za Multiple)
Select first object or ŠPolyline/Radius/Trim/mUltiple¹: (Izaberite ta~ku pored "A")
Select second object: (Izaberite ta~ku pored "B")
Select first object or ŠPolyline/Radius/Trim/mUltiple¹: (Izaberite ta~ku pored "B")
Select second object: (Izaberite ta~ku pored "C")
Select first object or ŠPolyline/Radius/Trim/mUltiple¹: (Izaberite ta~ku pored "C")
Select second object: (Izaberite ta~ku pored "D")
Select first object or ŠPolyline/Radius/Trim/mUltiple¹: (Pritisnite ENTER da iza|ete iz komande)

SLIKA 4.48

PROBAJTE!DDOtvorite crte` 04_Fillet Corner1. Komandom FILLET mogu}e je povezati linije koje
se ne seku. Ovo mo`ete uraditi tako {to }ete podesiti vrednost radijusa na 0. Ovako }e se 
formirati ugao u produ`etku objekata na koje se primenjuje komanda FILLET. Sledite ilustraciju
na slici 4.49 i donji niz zahteva za unos da biste izvr{ili ovu operaciju.
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Command: F (skra}enica za FILLET)
Current settings: Mode = TRIM, Radius = 0.5000
Select first object or ŠPolyline/Radius/Trim¹/mUltiple: R (za Radius)
Enter fillet radius <0.5000>: 0
Select first object or ŠPolyline/Radius/Trim¹ /mUltiple: (Izaberite liniju "A")
Select second object: (Izaberite liniju "B")

SLIKA 4.49

PROBAJTE!DDOtvorite crte` 04_Fillet Corner2. Aktivirajte komandu FILLET i proverite da li je
vrednost radijusa 0. Koristite opciju Multiple da biste ponovili komandu. Zatim, kliknite mi{em
na uglove sve dok va{ predmet ne izgleda kao {to je prikazano na slici 4.50.

SLIKA 4.50

PROBAJTE!DDOtvorite crte` 04_Fillet Pline. Ako koristite komandu FILLET sa objektom tipa
polilinije, svi uglovi polilinije mogu se zaobliti jednom operacijom. Sledite donji niz zahteva za
unos i sliku 4.51 da izvr{ite ovu komandu.

Command: F (skra}enica za FILLET)
Current settings: Mode = TRIM, Radius = 0.0000
Select first object or ŠPolyline/Radius/Trim¹/mUltiple: R (za Radius)
Enter fillet radius <0.0000>: 0.25
Select first object or ŠPolyline/Radius/Trim¹ /mUltiple: P (za Polyline)
Select 2D polyline: (Izaberite poliliniju sa slike 4.51)
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SLIKA 4.51

Komanda FILLET tako|e ima opciju Trim/No trim. Na slici 4.52 ura|eno je zaobljavanje sa 
odsecanjem krajeva linije i bez odsecanja.

PROBAJTE!DDOtvorite crte` 04_Fillet No-Trim. Slede}i niz zahteva za unos i slika 4.52 ilustruju
kori{}enje ove opcije komande FILLET.

Command: F (skra}enica za FILLET)
Current settings: Mode = TRIM, Radius = 0.0000
Select first object or ŠPolyline/Radius/Trim¹ /mUltiple: T (za Trim)
Enter Trim mode option ŠTrim/No trim¹ <Trim>: N (za No trim)
Select first object or ŠPolyline/Radius/Trim¹ /mUltiple: R (za Radius)
Specify fillet radius <0.0000>: 0.50
Select first object or ŠPolyline/Radius/Trim/mUltiple¹:P (za Polyline)
Select 2D polyline: (Izaberite poliliniju "A")
6 lines were filtered

N A P O M E N A

Vratite opciju Trim komande FILLET na Trim (sa No Trim). Ovo se mo`e uraditi pode{avanjem sistemske
promenljive TRIMMODE.

Command: TRIMMODE
Enter new value for TRIMMODE <0>: 1

PROBAJTE!DDOtvorite crte` 04_Fillet Paralle1. Primena komande FILLET na dve paralelne linije
(slika 4.53) automatski pravi luk pod uglom od 180 stepeni koji povezuje dve linije u njihovim
krajnjim ta~kama. Ovde ne treba unositi radijus izme|u ove dve linije; rastojanje izme|u njih
odredi}e i radijus. Koristite slede}i niz zahteva za unos i ilustraciju na slici 4.53 da biste izvr{ili
ovu operaciju.

Izaberite poliliniju

Polupre~nik=0.25



AutoCAD
®

2004 za in`enjere ma{instva

Command: F (skra}enica za FILLET)
Current settings: Mode = TRIM, Radius = 1.0000
Select first object or ŠPolyline/Radius/Trim¹/mUltiple: (Izaberite liniju "A")
Select second object: (Izaberite liniju "B")

Zavr{ite zaobljavanje preostalih linija. Ubrzajte proces kori{}enjem opcije Multiple na zahtev za
unos: Select first object.

SLIKA 4.52

SLIKA 4.53
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Komanda LENGTHEN
Komanda LENGTHEN koristi se za promenu du`ine izabranog objekta. Promena du`ine pomo}u
ove komande vr{i se bez promene osobina objekata. Na primer, ako se vr{i promena du`ine luka,
ne}e se promeniti njegov radijus. Izaberite ovu komandu na jedan od slede}ih na~ina:

sa padaju}eg menija (Modify>Lengthen),

pomo}u tastature (LEN ili LENGTHEN).

PROBAJTE!DDOtvorite crte` 04_Lengthen1. Koristite ilustraciju na slici 4.54 i niz zahteva za unos
da biste izvr{ili ovu operaciju.

Command: LEN (skra}enica za LENGTHEN)
Select an object or ŠDelta/Percent/Total/DYnamic¹: (Izaberite liniju "A")
Current length: 12.3649
Select an object or ŠDelta/Percent/Total/DYnamic¹: T (za Total)
Specify total length or ŠAngle¹ (1.0000) : 20
Select an object to change or ŠUndo¹: (Izaberite liniju pored "A")
Select an object to change or ŠUndo¹: (Pritisnite taster ENTER za izlazak iz komande)

PROBAJTE!DDOtvorite crte` 04_Lengthen2. Kada koristite komandu LENGTHEN na delu luka,
softver }e u komandnoj liniji dati informaciju o du`ini luka i zahva}enom uglu, kao na slici 4.55. 

Command: LEN (skra}enica za LENGTHEN)
Select an object or ŠDelta/Percent/Total/DYnamic¹: (Izaberite luk "B")
Current length: 8.0109, included angle: 87
Select an object or ŠDelta/Percent/Total/DYnamic¹: T (za Total)
Specify total length or ŠAngle¹ (1.0000) : 21
Select an object to change or ŠUndo¹: (Izaberite luk pored "B")
Select an object to change or ŠUndo¹: (Pritisnite taster ENTER za izlazak iz komande)

SLIKA 4.54 SLIKA 4.55
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Komanda MIRROR - na~in 1
Komanda MIRROR koristi se za pravljenje kopije objekta ili grupe objekata kao slike u ogledalu.
Mogu}e je i samo preslikati objekte, tj. okrenuti ih bez kopiranja. Izaberite ovu komandu na
jedan od slede}ih na~ina:

sa palete sa alatkama Modify,

sa padaju}eg menija (Modify>Mirror),

pomo}u tastature (MI ili MIRROR).

PROBAJTE!DDOtvorite crte` 04_Mirror Copy. Slede}i niz zahteva za unos i slika 4.56 prikazuju
kori{}enje opcije kopiranja komande MIRROR.

Command: MI (skra}enica za MIRROR)
Select objects: (Izaberite ta~ku pored "X")
Specify opposite corner: (Izaberite ta~ku pored "Y")
Select objects: (Pritisnite taster ENTER da biste nastavili)
Specify first point of mirror line: (Izaberite krajnju ta~ku osne linije pored "A")
Specify second point of mirror line: (Izaberite krajnju ta~ku osne linije pored "B")
Delete source objects? ŠYes/No¹ <N>: (Pritisnite taster ENTER da biste izabrali
ponu|enu vrednost)

Na slici 4.57 prikazan je objekat posle izvr{ene komande MIRROR. Ova komanda korisna je kada
se zahtevaju simetri~ni delovi.

SLIKA 4.56    SLIKA 4.57

Komanda MIRROR - na~in 2
Na slici 4.58 prikazan je drugi na~in primene komande MIRROR. Koristi se kada se `eli samo
preslikavanje objekta bez kopiranja.
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PROBAJTE!DDOtvorite crte` 04_Mirror Flip. Slede}i niz zahteva za unos i slika 4.43 prikazuju
kori{}enje opcije preslikavanja komande MIRROR. Rezultat je prikazan na slici 4.59.

Command: MI (skra}enica za MIRROR)
Select objects: All (Bi}e izabrani svi objekti na slici 4.58)
Select objects: (Pritisnite taster ENTER da biste nastavili)
Specify first point of mirror line: Mid
od (Izaberite sredi{nju ta~ku linije pored "A")
Specify second point of mirror line: Per
(Izaberite liniju "B" koja je normalna na ta~ku "A")
Delete source objects? ŠYes/No¹ <Y>: Y (za Yes)

SLIKA 4.58              SLIKA 4.59

Komanda MIRROR - na~in 3
U nekim situacijama potrebno je napraviti sliku teksta u ogledalu, kao na slici 4.60. Ovo kontroli{e
sistemska promenljiva MIRRTEXT. Po unapred odre|enom pode{avanju, njena vrednost je 1.

PROBAJTE!DDOtvorite crte` 04_Mirror Text. Slede}i niz zahteva za unos prikazuje kori{}enje
komande MIRROR za tekst.

Command: MI (skra}enica za MIRROR)
Select objects: (Izaberite ta~ku pored "X")
Specify opposite corner: (Izaberite ta~ku pored "Y")
Select objects: (Pritisnite taster ENTER da biste nastavili)
Specify first point of mirror line: (Izaberite krajnju ta~ku osne linije pored "A")
Specify second point of mirror line: (Izaberite krajnju ta~ku osne linije pored "B")
Delete source objects? ŠYes/No¹ <N>: (Pritisnite taster ENTER da biste usvojili
ponu|enu vrednost)

Primetite da je tekst okrenut kao slika u ogledalu, zato {to je sistemska promenljiva MIRRTEXT
pode{ena na vrednost 1 - uklju~ena je. Tekst nije ~itljiv (videti sliku 4.61). Zatvorite crte` i nemo-
jte sa~uvati promene.

PROBAJTE!DDPonovo otvorite crte` 04_Mirror Text. Da biste preslikali tekst ali bez okretanja, da
bi tekst bio ~itljiv, podesite vrednost sistemske promenljive MIRRTEXT na 0 ili Off. Videti sliku
4.62 i slede}i niz zahteva za unos.
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SLIKA 4.60

SLIKA 4.61 SLIKA 4.62

Command: MIRRTEXT
New value for MIRRTEXT <1>: 0

Kori{}enje komande MIRROR sa sistemskom promenljivom MIRRTEXT pode{enom na 0 ~ini tekst
~itljivim, kao na slici 4.62. Da biste ovo postigli, sledite niz zahteva za unos.

Command: MI (skra}enica za MIRROR)
Select objects: (Napravite skup objekata za izbor, kao na slici 4.60)
Select objects: (Pritisnite taster ENTER da biste nastavili)
Specify first point of mirror line: (Izaberite krajnju ta~ku osne linije pored "A")
Specify second point of mirror line: (Izaberite krajnju ta~ku osne linije pored "B")
Delete source objects? ŠYes/No¹ <N>: (Pritisnite taster ENTER za unapred odre|eno 

pode{avanje)

PROBAJTE!DDOtvorite crte` 04_Mirror Duplex. Podesite sistemsku promenljivu MIRRTEXT na
vrednost 0. Da biste napravili kopiranu sliku plana osnove Duplex floor kao u ogledalu, koristite
komandu MIRROR i liniju "AB" kao liniju oko koje se vr{i preslikavanje. Kona~ni izgled 
preslikanog objekta dat je na slici 4.63.
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SLIKA 4.63

Komanda MOVE
Komanda MOVE pomera objekat ili grupu objekata u crte`u. Izaberite ovu komandu na jedan od
slede}ih na~ina:

sa palete sa alatkama Modify,
sa padaju}eg menija (Modify>Move),
pomo}u tastature (M ili MOVE).

Pomeranje se vr{i preko dve ta~ke: prve, bazne ta~ke (base point of displacement) i druge ta~ke
(second point of displacement). Princip rada ove komande je isti kao za komandu COPY, ali se
objekti ne kopiraju, ve} se samo pomeraju. Bazna ta~ka je ta~ka za koju "vu~ete" objekat pri
pomeranju, ta~ka koja odre|uje odakle se vr{i pomeranje, a druga ta~aka odre|uje polo`aj bazne
ta~ke posle pomeranja, a posredno, preko bazne ta~ke, i polo`aj objekta koji se pomera (videti
sliku 4.64).

Command: M (skra}enica za MOVE)
Select objects: (Izaberite sve objekte nacrtane isprekidano na slici 4.64)
Select objects: (Pritisnite taster ENTER da biste nastavili)
Specify base point or displacement: (Izaberite krajnju ta~ku linije pored "A")
Specify second point of displacement or <use first point as displacement>: (Izaberite 

ta~ku pored "B")

PROBAJTE!DDOtvorite crte` 04_Move. @leb prikazan na slici 4.65 nije dobro postavljen. Njegov levi
kraj treba da bude za 1 jedinicu udaljen od leve ivice objekta. Ovde mo`ete primeniti komandu
MOVE u kombinaciji sa polarnim koordinatama ili sa metodom direktnog uno{enja rastojanja.
Slede}i niz zahteva za unos i slika 4.65 ilustruju ovu operaciju.

Spava}a soba 1

Dnevna soba Dnevna soba

Spava}a soba 1 Spava}a soba 1

Spava}a soba 2 Spava}a soba 2

Kupatilo Kupatilo

Kuhinja/trpezarija Kuhinja/trpezarija

PerionicaPerionica
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SLIKA 4.64

Command: M (skra}enica za MOVE)
Select objects: (Izaberite `leb i osne linije na slici 4.65)
Select objects: (Pritisnite taster ENTER da biste nastavili)
Specify base point or displacement: (Izaberite luk pored "A")
Specify second point of displacement or <use first point as displacement>: ª0.50<0

Po{to je `leb pomeren komandom MOVE, mora se postaviti nova horizontalna dimenzija da bi
se prikazalo pravo rastojanje od ivice objekta do osne linije luka (slika 4.66).

SLIKA 4.65          SLIKA 4.66

Komanda OFFSET
Kopiranje linija ovom komandom potpuno je isto kao komandom COPY. Ostali geometrijski 
oblici (npr. pravougaonik, ili neki drugi zatvoreni geometrijski oblik) kopiraju se ovom komandom
sa uve}anjem ili umanjenjem, tako {to se kopiranje vr{i oko zami{ljenog centra originalnog 
predmeta. Novi predmet je, na neki na~in, ''koaksijalan'' sa originalnim predmetom.

Izaberite ovu komandu na jedan od slede}ih na~ina:

sa palete sa alatkama Modify,
sa padaju}eg menija (Modify>Offset),
pomo}u tastature (O ili OFFSET).

Jedan na~in za offset kopiranje je kopiranje kroz odre|enu ta~ku. Po{to se izabere objekat koji se
kopira, defini{e se ta~ka kroz koju treba izvr{iti kopiranje. Ova operacija prikazana je na slici 4.67.
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PROBAJTE!DDOtvorite crte` 04_Offset1. Pogledajte sliku 4.67 i slede}i niz zahteva za unos da
biste videli kako funkcioni{e komanda OFFSET.

Command: O (skra}enica za OFFSET)
Specify offset distance or ŠThrough¹ <1.00> T (za Through)
Select objects to offset or <exit>: (Izaberite liniju pored "A")
Specify through point: Nod (Izaberite ta~ku pored "B")
Select object to offset or <exit>: (Pritisnite taster ENTER da biste napustili komandu)

Drugi na~in kopiranja komandom OFFSET je odre|ivanjem offset rastojanja. Na slici 4.68
odre|eno je rastojanje 0.50. Deo linije "A" je objekat koji treba kopirati. Potrebno je jo{ odrediti
stranu objekta na koju }e se izvr{iti kopiranje.

PROBAJTE!DDOtvorite crte` 04_Offset2. Sledite niz zahteva za unos i sliku 4.68 da biste kopirali
objekte na ovaj na~in.

Command: O (skra}enica za OFFSET)
Specify offset distance or ŠThrough¹ <1.00> 0.50
Select objects to offset or <exit>: (Izaberite liniju pored "A")
Specify through point: Nod of (Izaberite ta~ku pored "B")
Select object to offset or <exit>: (Pritisnite taster ENTER za izlazak iz komande)

SLIKA 4.67   SLIKA 4.68

Drugi na~in primene komande OFFSET prikazan je na slici 4.69. U ovom primeru potrebno je
kopirati objekte na odre|enom rastojanju u odnosu na postoje}i objekat. Ovu operaciju mogu}e
je odraditi primenom komande COPY, ali pogodnije je upotrebiti komandu OFFSET, koja vam
omogu}ava da odredite rastojanje i stranu sa koje }e se izabrani objekat paralelno kopirati. 
Svi objekti, koji su prikazani na slici 4.69, treba da se paralelno kopiraju ka unutra{njoj strani
postoje}eg objekta na rastojanju od 0.50 jedinica.
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PROBAJTE!DDOtvorite crte` 04_Offset3. Sledite niz zahteva za unos i slike 4.69 i 4.70 da biste
izveli ovu operaciju.

Command: O (skra}enica za OFFSET)
Specify offset distance or ŠThrough¹ <1.00> 0.50
Select objects to offset or <exit>: (Izaberite horizontalnu liniju pored "A")
Specify point on side to offset: (Izaberite bilo koju ta~ku u unutra{njosti pored "B")
Ponovite ovu proceduru za linije od "C" do "J".

Po{to su sve linije kopirane pojedina~no, zadr`ana je njihova originalna du`ina; neke linije se
seku i preklapaju (videti sliku 4.70), a neke se ne seku (linije "A" i "B"). Da bi se dobile o{tre
ivice, mo`ete koristiti komandu CHAMFER. Vrednost za rastojanje u komandi CHAMFER bi}e 0.

Command: CHA (skra}enica za CHAMFER)
(TRIM mode) Current chamfer Dist1 = 0.5000, Dist2 = 0.5000
Select first line or ŠPolyline/Distance/Angle/Trim/Method¹/mUltiple: D (za Distance)
Specify first chamfer distance <0.5000>: 0
Specify second chamfer distance <0.0000>: (Pritisnite taster ENTER da biste nastavili)
Select first line or ŠPolyline/Distance/Angle/Trim/Method¹/mUltiple: (Izaberite liniju 

pored "A" na slici 4.70)
Select second line (Izaberite liniju pored "B")

Ponovite ovu proceduru za linije od "B" do "I" na slici 4.70.

SLIKA 4.69  SLIKA 4.70

Kori{}enje komande OFFSET sa komandom CHAMFER daje rezultat kao na slici 4.71. Isti 
rezultat dobija se komandom FILLET kada se unese radijus 0.
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SLIKA 4.71

Komanda PEDIT
Ovde }e se prikazati nekoliko opcija editovanja polilinija. Izaberite ovu komandu na jedan od
slede}ih na~ina:

sa palete sa alatkama Modify,
sa padaju}eg menija (Modify>Object>Polyline),
pomo}u tastature (PE ili PEDIT).

Na slici 4.72 prikazana je polilinija debljine 0.00. Komanda PEDIT je zatim upotrebljena da bi se
promenila debljina polilinije na 0.10.

PROBAJTE!DDOtvorite crte` 04_Pedit Width. Slede}i niz zahteva za unos ilustruje kori{}enje
opcije Width komande PEDIT.

Command: PE (skra}enica za PEDIT)
Select polyline or ŠMultiple¹: (Izaberite poliliniju pored "A")
Enter an option ŠOpen/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype Gen/Undo¹: W
(za Width)
Specify new width for all segments: 0.10
Enter an option ŠOpen/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype Gen/Undo¹:
(Pritisnite taster ENTER da iza|ete iz komande)

Mogu}e je pretvoriti i pojedina~ne objekte u polilinije. Kao na slici 4.73, luk i linije mogu biti
pretvoreni u polilinije. Krug se ne mo`e pretvoriti u poliliniju, osim ako se komandom BREAK
pretvori u lukove.

SLIKA 4.72   SLIKA 4.73
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PROBAJTE!DDOtvorite crte` 04_Pedit Join1. Pogledajte sliku 4.73 i slede}i niz zahteva za unos
da biste pretvorili pojedina~ne linije u polilinije.

Command: PE (skra}enica za PEDIT)
Select polyline or ŠMultiple¹: (Izaberite liniju pored "A")
Object selected is not a polyline
Do you want to turn it into one?<Y> (Pritisnite taster ENTER da prihvatite ponu|enu
opciju)
Enter an option ŠClose/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype Gen/Undo¹: J

(za Join)
Select objects: (Izaberite linije od "B" do "D")
Select objects: (Pritisnite taster ENTER da biste spojili linije)
3 segments added to polyline
Enter an option ŠOpen/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype Gen/Undo¹: 

(Pritisnite taster ENTER da iza|ete iz komande)

U prethodnom primeru objekti su birani pojedina~no pre nego {to su pretvoreni u polilinije. Ako
ih ima vi{e, izbor mo`ete izvr{iti opcijom Window. Zatim, iskoristite opciju Join komande PEDIT.

N A P O M E N A

Sistemska promenljiva PEDITACCEPT mo`e da bude korisna prilikom menjanja polilinija. Prema unapred
odre|enom pode{avanju ova sistemska promenljiva je isklju~ena (vrednost joj je 0). Kada je uklju~ena
(vrednost joj je 1) i kada se izabere objekat koji treba pretvoriti u poliliniju ne}e se prikazati niz poruka koje
vas upozoravaju da izabrani objekat nije polilinija i da mo`ete da ga pretvorite u poliliniju. Objekat se
automatski pretvara u poliliniju. Vrednost ove promenljive mora da se podesi preko komandne linije, kao
{to je to prikazano u datom primeru:

Command: PEDITACCEPT
Enter new value for PEDITACCEPT <0>: 1 (Da biste je uklju~ili)

PROBAJTE!DDOtvorite crte` 04_Pedit Join2. Pogledajte sliku 4.74 i slede}i niz zahteva za unos
da biste koristili ovu komandu.

Command: PE (skra}enica za PEDIT)
Select polyline or ŠMultiple¹: (Izaberite liniju pored "A")
Object selected is not a polyline
Do you want to turn it into one?<Y> (Pritisnite taster ENTER da prihvatite ponu|enu opciju)
Enter an option ŠClose/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype Gen/Undo¹: J

(za Join)
Select objects: (Izaberite ta~ku pored "B")
Specify opposite corner: (Izaberite ta~ku pored "C")
Select objects: (Pritisnite taster ENTER da biste spojili linije)
56 segments added to polyline
Enter an option ŠOpen/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype Gen/Undo¹: 

(Pritisnite taster ENTER da iza|ete iz komande)
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SLIKA 4.74

Polilinija na slici 4.75 koristi}e se kao polazni objekat za stvaranje krivih. Na slikama 4.76 i 4.77
prikazane su dve opcije stvaranja glatkih krivih na osnovu polilinije. To su opcije Spline i Fit
Curve. Opcija Spline proizvodi glatku krivu zasnovanu na ta~kama polilinije kao kontrolnim
ta~kama. Opcija Fit Curve formira glatku krivu koja prolazi ta~no kroz ta~ke polilinije. Prou~ite
slike 4.77 i 4.78 koje ilustruju primenu opcija komande PEDIT.

SLIKA 4.75

Generisanje krive Spline

PROBAJTE!DDOtvorite crte` 04_Pedit Spline Curve. Pogledajte sliku 4.76 i slede}i niz zahteva za
unos da biste koristili ovu komandu.

Command: PE (skra}enica za PEDIT)
Select polyline or ŠMultiple¹: (Izaberite poliliniju pored "A")
Enter an option ŠClose/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype gen/Undo¹: S

(za Spline)
Enter an option ŠClose/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype gen/Undo¹: 

(Pritisnite taster ENTER da iza|ete iz ove komande)

Polilinija koja slu`i kao osnova za konstrukciju neke krive obi~no se ne prikazuje prilikom 
generisanja krive. Ovde je prikazana radi ilustracije.

SLIKA 4.76
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Generisanje krive Fit Curve

PROBAJTE!DDOtvorite crte` 04_Pedit Fit Curve. Pogledajte sliku 4.77 i slede}i niz zahteva za
unos da biste koristili ovu komandu.

Command: PE (skra}enica za PEDIT)
Select polyline or ŠMultiple¹: (Izaberite poliliniju pored "B")
Enter an option ŠClose/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype gen/Undo¹: F

(za Fit)
Enter an option ŠClose/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype gen/Undo¹: 

(Pritisnite taster ENTER da iza|ete iz ove komande)

Opcija Linetype Generation komande PEDIT kontroli{e izgled polilinije od ta~ke do ta~ke. 
Na slici 4.78 prikazane su razli~ite polilinije.

PROBAJTE!DDOtvorite crte` 04_Pedit Ltype Gen. Pogledajte sliku 4.78 i slede}i niz zahteva za
unos da biste koristili ovu komandu.

Command: PE (skra}enica za PEDIT)
Select polyline or ŠMultiple¹: (Izaberite poliliniju pored "D" na slici 4.78)
Enter an option ŠClose/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype gen/Undo¹: Lt

(za Ltype gen)
Enter polyline linetype generation option ŠON/OFF¹ <Off>: On
Enter an option ŠClose/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype gen/Undo¹: 

(Pritisnite taster ENTER da iza|ete iz ove komande)

SLIKA 4.77 SLIKA 4.78

Objekat na slici 4.79 isti je kao onaj na slici 4.69. Postoji lak{i na~in za dobijanje objekata offset
kopiranjem. Komanda OFFSET kopira slo`ene objekte (mnogougaonike, krugove, polilinije i
sli~ne geometrijske figure) i istovremeno ih uve}ava ili umanjuje. Pri tome ivice objekata ostaju
paralelne, a uslovni centar ovako kopiranog objekta (ako postoji) ostaje isti.
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PROBAJTE!DDOtvorite crte` 04_Pedit Offset. Prvo je potrebno komandom PEDIT sve linije
pretvoriti u jednu poliliniju.

Command: PE (skra}enica za PEDIT)
Select polyline or ŠMultiple¹: (Izaberite liniju pored "A")
Object selected is not a polyline
Do you want to turn it into one?<Y> (Pritisnite taster ENTER da prihvatite ponu|enu opciju)
Enter an option ŠClose/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype Gen/Undo¹: J 

(za Join)
Select objects: (Izaberite ta~ku pored "X")
Specify opposite corner: (Izaberite ta~ku pored "Y")
Select objects: (Pritisnite taster ENTER da biste nastavili)
8 lines added to polyline
Enter an option ŠOpen/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype Gen/Undo¹: 

(Pritisnite taster ENTER da iza|ete iz ove komande)

Komanda OFFSET koristi se za kopiranje ovog oblika za 0.50 jedinica ka unutra. Po{to je objekat
pretvoren u poliliniju, svi objekti se kopiraju istovremeno. Sada nije potrebno koristiti komande
CHAMFER ili FILLET. Pogledajte sliku 4.80.

Command: O (skra}enica za OFFSET)
Specify offset distance or ŠThrough¹: <1.0000>: 0.50
Select object to offset or <exit>: (Izaberite poliliniju pored "A")
Select point on side to offset: (Izaberite ta~ku negde pored "B")
Select object to offset or <exit>: (Pritisnite taster ENTER da iza|ete iz ove komande)

SLIKA 4.79  SLIKA 4.80
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Vi{estruko editovanje polilinija
Mogu}e je odjednom pretvoriti vi{e objekata u polilinije. Ovo je mogu}e pomo}u komande
PEDIT i opcije Multiple.

PROBAJTE!DDOtvorite crte` 04_Pedit Multiple1. Pogledajte slede}i niz zahteva za unos i sliku
4.81 da biste koristili komandu MPEDIT.

Command: PE (skra}enica za PEDIT)
Select polyline or ŠMultiple¹: M (za Multiple)
Select objects: (Izaberite luk i delove linije na slici 4.81)
Select objects: (Pritisnite taster ENTER da biste nastavili)
Convert Lines and Arcs to polylines ŠYes/No¹ <Y> Y (za Yes)
Enter an option ŠOpen/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype Gen/Undo¹: W

(za Width)
Specify new width for all segments: 0.05
Enter an option ŠOpen/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype Gen/Undo¹: 

(Pritisnite taster ENTER da iza|ete iz komande)

SLIKA 4.81

Pomo}u opcije Multiple komande PEDIT mogu se u poliliniju spojiti i linije koje nisu susedne,
tj. nemaju zajedni~ke ta~ke. Mogu se spojiti dve linije izme|u kojih postoji razmak ili koje se
preklapaju. Kada izaberete objekte koji }e biti spojeni, zahtev za unos tra`i da unesete faktor 
rastojanja. To rastojanje }e se koristiti kao grani~no. Ako je rastojanje izme|u linija ve}e, one se
ne}e spojiti u poliliniju. Isto je i ako je preklop izme|u linija ve}i. Da biste odredili ovu vrednost,
izmerite rastojanje izme|u dva objekta koja su kriti~na. Prou~ite sliku 4.82 da biste bolje
razumeli koncept faktora rastojanja. Na slici 4.82 treba spojiti tanke linije u jednu poliliniju.
Linije koje se spajaju mogu biti obi~ne linije ili polilinije.
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PROBAJTE!DDOtvorite crte` 04_Pedit Multiple2. Da biste izvr{ili ovu operaciju, prou~ite sliku
4.82 i slede}i niz zahteva za unos.

Command: PE (skra}enica za PEDIT)
Select polyline or ŠMultiple¹: M (za Multiple)
Select objects: (Izaberite linije "A" i "B" sa slike 4.82)
Select objects: (Pritisnite taster ENTER da biste nastavili)
Convert Lines and Arcs to polylines ŠYes/No¹ <Y> Y (za Yes)
Enter an option ŠClose/Open/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype
Gen/Undo¹: J (za Join)
Join Type = Extend
Enter fuzz distance or ŠJointype¹ <0.0000> 0.44
1 segments added to polyline 
Enter an option ŠClose/Open/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype Gen/Undo¹: 

(Pritisnite taster ENTER da biste napustili komandu)

Command: PE (skra}enica za PEDIT)
Select polyline or ŠMultiple¹: M (za Multiple)
Select objects: (Izaberite linije "C" i "D" sa slike 4.82)
Select objects: (Pritisnite taster ENTER da biste nastavili)
Convert Lines and Arcs to polylines ŠYes/No¹ <Y> Y (za Yes)
Enter an option ŠClose/Open/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype 

Gen/Undo¹: J (za Join)
Join Type = Extend
Enter fuzz distance or ŠJointype¹ <0.4400> 0.92
1 segments added to polyline 
Enter an option ŠClose/Open/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype 

Gen/Undo¹: (Pritisnite taster ENTER da biste napustili komandu)

SLIKA 4.82
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Komanda ROTATE
Komanda ROTATE okre}e neki objekat ili grupu objekata oko neke bazne ta~ke za odre|eni ugao
rotacije. Izaberite ovu komandu na jedan od slede}ih na~ina:

sa palete sa alatkama Modify,

sa padaju}eg menija (Modify>Rotate),

pomo}u tastature (RO ili ROTATE).

Slika 4.83 prikazuje {rafirani objekat koji treba rotirati oko bazne ta~ke "A" za ugao od 30 
stepeni.

PROBAJTE!DDOtvorite crte` 04_Rotate. Da biste rotirali objekat, koristite slede}i niz zahteva za
unos i ilustraciju na slici 4.83.

Command: RO (skra}enica za ROTATE)
Current positive angle in UCS: ANGDIR=counterclockwise ANGBASE=0
Select objects: All
Select objects: (Pritisnite taster ENTER da biste nastavili)
Specify base point: (Izaberite krajnju ta~ku linije pored "A")
Specify rotation angle or ŠReference¹: 30

Komanda ROTATE-Reference
Ponekad je potrebno da objekat u crte`u bude pod nekim uglom u odnosu na neki referentni
pravac. Ovo mo`e predstavljati problem ako je trenutni ugao objekta nepoznat. Zbog toga 
postoji opcija Reference. Na slici 4.84 prikazan je objekat ~ija osa treba da bude pod uglom 
od 30 stepeni u odnosu na horizontalni pravac. Referentni ugao se obi~no defini{e kao ugao u
odnosu na horizontalu.

PROBAJTE!DDOtvorite crte` 04_Rotate Reference. Koristite slede}i niz zahteva za unos i sliku
4.84 da biste izvr{ili ovu rotaciju.

Command: RO (skra}enica za ROTATE)
Current positive angle in UCS: ANGDIR=counterclockwise ANGBASE=0
Select objects: (Izaberite objekat na slici 4.84)
Select objects: (Pritisnite taster ENTER da biste nastavili)
Specify base point: (Izaberite kru`nicu ili dva lu~na segmenta da biste odredili centar)
Specify rotation angle or ŠReference¹: R (za Reference)
Specify the reference angle <0>: (Izaberite kru`nicu ili dva lu~na segmenta da biste
odredili centar)
Specify second point: Mid
od (Izaberite liniju pored "A" da biste definisali referentni ugao)
Specify the new angle: 30
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SLIKA 4.83 SLIKA 4.84

Komanda SCALE
Komanda SCALE koristi se da bi se promenila ukupna veli~ina objekta. Veli~ina mo`e biti manja
ili ve}a u odnosu na originalni objekat ili grupu objekata. Komanda SCALE zahteva odre|ivanje
bazne ta~ke i faktora razmere. Izaberite ovu komandu na jedan od slede}ih na~ina:

sa palete sa alatkama Modify,

sa padaju}eg menija (Modify>Scale),

pomo}u tastature (SC ili SCALE). 

Objekat sa slike 4.85 bi}e nacrtan u razli~itim veli~inama (slike 4.86 i 4.87).

PROBAJTE!DDOtvorite crte` 04_Scale1. Na slici 4.86 prikazan je objekat nacrtan sa faktorom
razmere 0.50 i baznom ta~kom "A".

Command: SC (skra}enica za SCALE)
Select objects: All
Select objects: (Pritisnite taster ENTER da biste nastavili)
Specify base point: (Izaberite krajnju ta~ku linije pored "A")
Specify scale factor or ŠReference¹: 0.50
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SLIKA 4.85    SLIKA 4.86

PROBAJTE!DDOtvorite crte` 04_Scale2. Primer na slici 4.87 prikazuje efekat promene bazne
ta~ke objekta.

Command: SC (skra}enica za SCALE)
Select objects: All
Select objects: (Pritisnite taster ENTER da biste nastavili)
Specify base point: (Izaberite ta~ku pored "A")
Specify scale factor or ŠReference¹: 0.40

SLIKA 4.87

Komanda SCALE-Reference
Pretpostavimo da imamo objekat ~ija je razmera umanjena. Me|utim, ne znamo koji je ta~an 
faktor razmere. Ipak, zna se ta~na vrednost jednog rastojanja na objektu. U ovom slu~aju, da biste
odredili krajnje ta~ke linije, ~ija se du`ina uzima kao referentna du`ina, mo`ete koristiti opciju
Reference komande SCALE. Ako unesete novu vrednost za ovu du`inu, promeni}e se dimenzije
celog objekta.

PROBAJTE!DDOtvorite crte` 04_Scale Reference. Da biste izveli ovu operaciju, prou~ite sliku 4.88
i slede}i niz zahteva za unos.

Command: SC (skra}enica za SCALE)
Select objects: (Izaberite ta~ku pored "A")
Specify opposite corner: (Izaberite ta~ku pored "B")
Select objects: (Pritisnite taster ENTER da biste nastavili)
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Specify base point (Izaberite kru`nicu da biste odredili centar)
Specify scale factor or ŠReference¹: R (za Reference)
Specify reference length <1>: (Izaberite krajnju ta~ku linije pored "C")
Specify second point: (Izaberite krajnju ta~ku linije pored "D")
Specify new length: 2.00

Po{to du`ina linije "CD" nije poznata, krajnje ta~ke ove linije izabrane su kada je unesena opcija
Reference. Sada }e AutoCAD ovu veli~inu smatrati za referentnu. Kada se ova veli~ina promeni na
2.00 jedinica, u tako definisanoj razmeri uve}a}e se i ostale dimenzije objekta.

SLIKA 4.88

Komanda STRETCH
Komanda STRETCH koristi se za pomeranje dela crte`a dok se neki njegov drugi deo ne pomera.
Izaberite ovu komandu na jedan od slede}ih na~ina:

sa palete sa alatkama Modify,

sa padaju}eg menija (Modify>Stretch),

pomo}u tastature (S ili STRETCH).

Moglo bi se re}i da se radi o razvla~enju ili izdu`ivanju objekta. Da biste izvr{ili ovu operaciju,
morate izabrati objekte opcijom Crossing. Zatim, potrebno je definisati baznu ta~ku, u primeru
sa slike 4.89, kao krajnju ta~ku pored "C". Kona~no, druga ta~ka za pomeranje mo`e se definisati
i preko polarnih koordinata, kao {to je ovde slu~aj, ili direktnim uno{enjem rastojanja. Izabrani
deo objekta se pomera, a ~itav objekat se razvla~i.

PROBAJTE!DDOtvorite crte` 04_Stretch1. Koristite sliku 4.89 i donji niz zahteva za unos da biste
izvr{ili ovu operaciju.
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Command: S (skra}enica za STRETCH)
Select objects to stretch by crossing window or crossing polygon…
Select objects: (Izaberite ta~ku pored "A")
Specify opposite corner: (Izaberite ta~ku pored "B")
Select objects: (Pritisnite taster ENTER da biste nastavili)
Specify base point or displacement: (Izaberite krajnju ta~ku linije pored "C")
Specify second point of displacement: ª1.75<180

PROBAJTE!DDOtvorite crte` 04_Stretch2. Na slici 4.90 je jo{ jedan primer kori{}enja komande
STRETCH. Izbor objekata je izvr{en opcijom Crossing. Bazna ta~ka je ta~ka "C". Upotrebljene su
polarne koordinate. Za ovu operaciju koristite donji niz zahteva za unos i sliku 4.90.

Command: S (skra}enica za STRETCH)
Select objects to stretch by crossing window or crossing polygon…
Select objects: (Izaberite ta~ku pored "A")
Specify opposite corner: (Izaberite ta~ku pored "B")
Select objects: (Pritisnite taster ENTER da biste nastavili)
Specify base point or displacement: (Izaberite krajnju ta~ku linije pored "C")
Specify second point of displacement: ª1.00<0

SLIKA 4.89   SLIKA 4.90

Primena komande STRETCH prikazana je na slici 4.91. Prozor treba pomeriti na drugo mesto.

PROBAJTE!DDOtvorite crte` 04_Stretch3. Za ovu operaciju koristite donji niz zahteva za unos i
sliku 4.91.
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Command: S (skra}enica za STRETCH)
Select objects to stretch by crossing window or crossing polygon…
Select objects: (Izaberite ta~ku pored "A")
Specify opposite corner: (Izaberite ta~ku pored "B")
Select objects: (Pritisnite taster ENTER da biste nastavili)
Specify base point or displacement: Mid
od (Izaberite srednju ta~ku linije pored "C")
Specify second point of displacement: ª10'6<0

SLIKA 4.91

Komanda TRIM
Komanda TRIM se koristi za delimi~no brisanje objekta ili grupe objekata do ivice za odsecanje.
Izaberite ovu komandu na jedan od slede}ih na~ina:

sa palete sa alatkama Modify,

sa padaju}eg menija (Modify>Trim),

pomo}u tastature (TR ili TRIM).

Na slici 4.92 definisane su ~etiri isprekidane linije kao ivice za odsecanje. Zatim, delovi kruga su
izabrani za delimi~no brisanje/odsecanje izme|u ivica za odsecanje.

PROBAJTE!DDOtvorite crte` 04_Trim1. Koristite donji niz zahteva za unos i sliku 4.92 za ovu
operaciju.

Command: TR (skra}enica za TRIM)
Current settings: Projection=UCS Edge=None
Select cutting edges…
Select objects: (Izaberite ~etiri isprekidane linije na slici 4.92)
Select objects: (Pritisnite taster ENTER da biste nastavili)
Select object object to extend or shift-select to trim or ŠProject/Edge/Undo¹: 

(Izaberite krug pored "A")
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Select object object to extend or shift-select to trim or ŠProject/Edge/Undo¹: (Izaberite 
krug pored "B")

Select object object to extend or shift-select to trim or ŠProject/Edge/Undo¹: (Izaberite 
krug pored "C")

Select object object to extend or shift-select to trim or ŠProject/Edge/Undo¹: (Izaberite 
krug pored "D")

Select object object to extend or shift-select to trim or ŠProject/Edge/Undo¹: (Pritisnite 
taster ENTER da iza|ete iz komande)

SLIKA 4.92

PROBAJTE!DDOtvorite crte` 04_Trim2. Postoji jo{ jedan na~in izbora ivica za odsecanje. Na
zahtev za unos "Select objects" mo`ete pritisnuti taster ENTER. Ovako su za ivice za odsecanje
izabrani svi objekti u crte`u. Kada koristite ovaj metod, ivice za odsecanje nisu istaknute. Na slici
4.93 izaberite linije "A", "B" i "E", i lu~ne segmente "C" i "D" kao objekte koje treba odce}i.

Command: TR (skra}enica za TRIM)
Current settings: Projection=UCS Edge=None
Select cutting edges…
Select objects: (Pritisnite taster ENTER da defini{ete sve elemente kao ivice za odsecanje)
Select object object to extend or shift-select to trim or ŠProject/Edge/Undo¹: (Izaberite 

deo pored "A")
Select object object to extend or shift-select to trim or ŠProject/Edge/Undo¹: (Izaberite 

deo pored "B")
Select object object to extend or shift-select to trim or ŠProject/Edge/Undo¹: (Izaberite

deo pored "C")
Select object object to extend or shift-select to trim or ŠProject/Edge/Undo¹: (Izaberite 

deo pored "D")
Select object object to extend or shift-select to trim or ŠProject/Edge/Undo¹: (Pritisnite 

taster ENTER da iza|ete iz komande)
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PROBAJTE!DDOtvorite crte` 04_Trim Fence. Ovde }ete videti veoma korisnu primenu opcije
Fence za izbor objekata. Startujte komandu TRIM i izaberite manji krug sa slike 4.94 kao ivicu za
odsecanje. Zatim }ete, metodom Fence, kao objekte za odsecanje definisati sve radijalne linije.
Napomena: mod OSNAP bi trebalo da bude isklju~en.

SLIKA 4.93

Command: TR (skra}enica za TRIM)
Current settings: Projection=UCS Edge=None
Select cutting edges…
Select objects: (Izaberite mali krug)
Select objects: (Pritisnite taster ENTER da biste nastavili)
Select object object to extend or shift-select to trim or ŠProject/Edge/Undo¹: F

za Fence)

SLIKA 4.94

Nastavite da upotrebljavate komandu TRIM tako {to }ete definisati ogradu (Fence). Ona se 
sastoji od niza isprekidanih linija. Svaki objekat koji ona prese~e bi}e izabran. Kada nacrtate
ogradu, kao na slici 4.95, pritisnite taster ENTER. Po~nite unutar manjeg kruga.
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First fence point: (Izaberite ta~ku pored "A")
Specify endpoint of line or ŠUndo¹: (Izaberite ta~ku pored "B")
Specify endpoint of line or ŠUndo¹: (Izaberite ta~ku pored "C")
Specify endpoint of line or ŠUndo¹: (Izaberite ta~ku pored "D")
Specify endpoint of line or ŠUndo¹: (Izaberite ta~ku pored "E")
Specify endpoint of line or ŠUndo¹: (Izaberite ta~ku pored "F")
Specify endpoint of line or ŠUndo¹: (Izaberite ta~ku pored "G")
Specify endpoint of line or ŠUndo¹: (Izaberite ta~ku pored "H")
Specify endpoint of line or ŠUndo¹: (Pritisnite taster ENTER da zavr{ite upotrebu opcije 

Fence i izvr{ite operaciju TRIM)
Select object to extend or shift-select to trim or ŠProject/Edge/Undo¹: (Pritisnite taster 

ENTER da iza|ete iz komande)

Na slici 4.96 prikazana je karakteristi~na primena izbora objekata opcijom Fence. Na ovaj na~in
izbegnuto je pojedina~no biranje svih linija, ili zahvatanje objekata koje nije trebalo izabrati
opcijama Window i Crossing.

SLIKA 4.95    SLIKA 4.96

Komanda TRIM ima mogu}nost odsecanja objekata do produ`ene ivice za odsecanje. Ovo zna~i
da je ivicu za odsecanje mogu}e zami{ljeno produ`iti u modu Extended Cutting Edge. Mogu}e je
odse}i deo objekta, do zami{ljenog produ`etka ivice za odsecanje, a ne do same ivice.

PROBAJTE!DDOtvorite crte` 04_Trim Edge. Prou~ite sliku 4.97 i sledite niz zahteva za unos za
ovu opciju komande TRIM.

Command: TR (skra}enica za TRIM)
Current settings: Projection=UCS Edge=None
Select cutting edges…
Select objects: (Izaberite liniju "A")
Select objects: (Pritisnite taster ENTER da biste nastavili)
Select object to extend or shift-select to trim or ŠProject/Edge/Undo¹: E (za Edge)
Enter an implied edge extension mode ŠExtend/No extend¹ <No extend>: E (za Extend)
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Select object to extend or shift-select to trim or ŠProject/Edge/Undo¹: E (Izaberite liniju 
pored "B" zajedno sa ostalim segmentima)

Select object to extend or shift-select to trim or ŠProject/Edge/Undo¹: E (Pritisnite taster 
ENTER da iza|ete iz komande)

Objekte mo`ete izabrati i opcijom Fence.

SLIKA 4.97

N A P O M E N A

Ponovo podesite opciju Edge komande TRIM na "No extend" (prethodnim nizom zahteva za unos, ova opci-
ja bila je pode{ena na "Extend"). Ovo mo`ete uraditi pomo}u komande EDGEMODE, koju mo`ete uneti sa
tastature i zatim njenu vrednost podesiti na 0.

Command: EDGEMODE
Enter new value for EDGEMODE <1>:0

Ako na zahtev za izbor objekata kao ivica za odsecanje pritisnete taster ENTER, izabra}ete sve
objekte u crte`u. Kasnije morate voditi ra~una o tome. Slede}e ve`banje razmatra ovaj problem.

PROBAJTE!DDOtvorite crte` 04_Trim3. Treba da uklonite {est vertikalnih linija iz unutra{njosti
objekta. Ako pomo}u tastera ENTER izaberete sve ivice za odsecanje, mora}ete da uklanjate sve
delove vertikalnih linija pojedina~no. Ako izaberete samo linije "A" i "B", kao na slici 4.98, mo}i
}ete da izaberete samo unutra{nje vertikalne linije. U ovom slu~aju to je efikasnije.

SLIKA 4.98
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PROBAJTE!DDOtvorite crte` 04_Trim Walls. Upotrebite komandu TRIM da odse~ete sve dodatne
linije i dobijete izgled plana osnove kao na slici 4.99.

SLIKA 4.99

S A V E T

Dok ste u komandi TRIM, mo`ete se lako prebaciti u komandu EXTEND dr`e}i pritisnut taster SHIFT pri
slede}em zahtevu za unos:

Select objects to trim or shift-select to extend or ŠProject/Edge/Undo¹:

Komanda UNDO
Komandu UNDO mo`ete koristiti da poni{tite prethodnu akciju ili komandu. Izaberite ovu
komandu na jedan od slede}ih na~ina:

sa palate sa alatkama Standard,

sa padaju}eg menija (Edit>Undo),

pomo}u tastature (U ili UNDO).

Na primer, ako nacrtate luk, zatim liniju, a potom krug, izvr{avanje komande UNDO }e poni{titi
dejstvo poslednje komande, u ovom slu~aju bi se krug uklonio iz baze podataka crte`a. Ova
komanda je jedan od najlak{ih na~ina za uklanjanje podataka ili vra}anje u prethodno stanje.
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Na paleti sa alatkama Standard nalazi se lista Undo (slika 4.100) pomo}u koje mo`ete poni{titi
nekoliko poslednjih akcija. U ovom primeru, za poni{tavanje su ozna~ene komande Line, Trim,
Fillet i Offset.

SLIKA 4.100

Napomena: Nije mogu}e izabrati neke komande za poni{tavanje, a neke presko~iti. Na primer, u
gornjem primeru nije mogu}e izabrati Offset i Trim a presko~iti Fillet. 

Komanda REDO
Dejstvo komande Undo mogu}e je poni{titi komandom Redo, ali samo odmah posle operacije
Undo. Izaberite ovu komandu na jedan od slede}ih na~ina:

sa palete sa alatkama Standard,

sa padaju}eg menija (Edit>Redo),

pomo}u tastature (REDO).

Klikom na komandno dugme Redo na paleti Standard poni{ti}ete jednu Undo operaciju. Ako je
bilo vi{e Undo operacija, njih je tako|e mogu}e poni{titi sa nekoliko uzastopnih Redo komandi.

Kao i kod komande Undo, mogu}e je ponoviti nekoliko prethodnih akcija preko padaju}e liste
Redo (slika 4.101). Ovoj listi mo`e se pristupiti sa palete Standard.

SLIKA 4.101

N A P O M E N A

Komanda Redo bi}e aktivna samo ako je prethodno izvr{ena akcija Undo. Ina~e, ova komanda je 
neaktivna.
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Primer za ve`banje: Clutch.dwg

SLIKA 4.102

Svrha

Svrha ovog ve`banja je pravljenje crte`a spojnica, prikazanih na slici 4.102, kori{}enjem
komande ARRAY i uno{enjem vrednosti preko koordinata.

Sistemska pode{avanja

Koristite uobi~ajena pode{avanja za jedinice i granice crte`a: (0,0) za donji levi ugao i (12,9) za
gornji desni ugao. Uklju~ite slede}e opcije moda OSNAP: Endpoint, Extension, Intersection,
Center i Quadrant.

Slojevi

Napravite slojeve sa slede}im pode{avanjem:

Name Color Linetype

Object White Continuous

Center Yellow Center

Predlozi za rad

Nacrtajte osnovni oblik kori{}enjem komandi LINE i CIRCLE. Prvo nacrtajte osnovni krug, jedan
kvadratni oblik, a zatim pomo}u komande ARRAY napravite vi{estruku kopiju kvadratnog 
oblika opcijom Polar.

Kad god je mogu}e, zamenite celu AutoCAD-ovu komandu odgovaraju}om skra}enicom u
svakom koraku ve`banja. Na primer, koristite "CP" za komandu COPY, "L" za komandu LINE itd.
Potpuni pregled skra}enica komandi nalazi se u tabeli 1.2.
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Korak 1

Proverite da li je teku}i sloj "Object". To uradite
kori{}enjem polja za editovanje Layer Control,
kao na slici 4.103. Nacrtajte krug sa centrom u
apsolutnim koordinatama (6.00,5.00) i radiju-
som 2.625 kao na slici 4.104. Zatim, nacrtajte
jo{ jedan krug unutar ovog, sa pre~nikom od
1.75 jedinica.

Command: C (skra}enica za 
CIRCLE)

Specify center point for circle or
Š3P/2P/Ttr (tan tan radius)¹: 6.00,5.00
Specify radius of circle or ŠDiameter¹: 

2.625

Command: C (za CIRCLE)
Specify center point for circle or
Š3P/2P/Ttr (tan tan radius)¹: 6.00,5.00
(ili izaberite centar prvog kruga
koriste}i Object Snap)
Specify radius of circle or ŠDiameter¹:
<2.6250>: D (za Diameter)
Specify diameter of circle <5.2500>:
1.75

Korak 2

Da biste nacrtali donji desni ugao spojnica,
koristite metod direktnog uno{enja rastojanja
zajedno sa modom Polar tracking. Pogledajte
sliku 4.105.

Command: L (skra}enica za LINE)
Specify first point: (Izaberite kvadrant
kruga pored "A")
Specify next point or ŠUndo¹: (Pomerite
kursor iznad kvadranta "B" da biste
ozna~ili ovu ta~ku; nemojte je izabrati.
Zatim, spustite kursor nadole sve dok se
ne izravna sa pravcem kvadranta "A".
Tada izaberite ovu ta~ku pored "C".)
Specify next point or ŠUndo¹: (Pritisnite
taster ENTER da biste napustili komandu)

SLIKA 4.103

SLIKA 4.104

SLIKA 4.105
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Korak 3

Upotrebite komandu TRIM da izbri{ete 
~etvrtinu kruga. Pritisnite taster ENTER da
izaberete sve horizontalne i vertikalne linije
prikazane na slici 4.106 i izaberite krug 
pored "A".

Command: TR (skra}enica za 
TRIM)

Current settings: Projection=UCS 
Edge=None

Select cutting edges…
Select objects: (Pritisnite taster ENTER 

da biste izabrali sve objekte na 
crte`u)

Korak 4

Izaberite sloj "Center" za teku}i, koriste}i polje
za editovanje Layer Control kao na slici 4.107.
Podesite vrednost sistemske promenljive 
DIMCEN na -0.09 jedinica. Koristite komandu
DIMCENTER da nacrtate osne linije kroz 
centar kruga, kao na slici 4.108. Izbri{ite donji
segment osne linije.

Command: DIMCEN
Enter new value for DIMCEN

<0.0900>: -0.09

Command: DCE (skra}enica za 
DIMCENTER)

Select arc or circle: (Izaberite luk pored
"A")

Command: E (za ERASE)
Select objects: (Izaberite donju osnu 

liniju pored "B")
Select objects: (Pritisnite taster ENTER 

da zavr{ite komandu)

SLIKA 4.106

Select object to extend or shift-select to 
trim or ŠProject/Edge/Undo¹: 
(Izaberite krug pored "A")

Select object to extend or shift-select to 
trim or ŠProject/Edge/Undo¹: (Pritisnite 
taster ENTER da biste napustili 
komandu)

SLIKA 4.107

SLIKA 4.108
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Korak 5

Dok ste u sloju "Center", nacrtajte krug sa
osnom linijom pre~nika 3.00, kao na slici 4.109.

Command: C (skra}enica za 
CIRCLE)

Specify center point for circle or
Š3P/2P/Ttr (tan tan radius)¹: 6.00,5.00
Specify radius of circle or ŠDiameter¹:
<0.8750>: D (za Diameter)
Specify diameter of circle <1.7500>: 

3.00

Korak 6

Vratite se u sloj "Object" (videti sliku 4.103).
Komandom ZOOM uve}ajte gornji deo spo-
jnice, kao na slici 4.110, da biste nacrtali
kvadrat.

Command: Z (skra}enica za 
ZOOM)

Specify corner of window enter a scale 
factor (nX or nXP), or

ŠAll/Center/Dynamic/Extents/Previous/S
cale/Window¹ <real time>: (Izaberite 

ta~ku pored "A")
Specify opposite corner: (Izaberite 

ta~ku pored "B")

Korak 7

Nacrtajte kvadrat dimenzija 0.50 x 0.50
koriste}i komandu RECTANG, pomo}u 
opcija From i Intersection moda OSNAP 
(videti sliku 4.111).

Command: REC (skra}enica za 
RECTANG)

Specify first corner point or ŠChamfer/
Elevation/Fillet/Thickness/Width¹: From

Base point: (Izaberite presek pored "A" 
na slici 4.111)

<Offset>: ª0.25<180
Specify other corner point: ª0.50,0.50

Upotrebite komandu ZOOM-Previous da
biste se vratili u prethodni prikaz.

SLIKA 4.109

SLIKA 4.110

SLIKA 4.111

Command: Z (skra}enica za 
ZOOM)

Specify corner of window enter a scale 
factor (nX or nXP), or

ŠAll/Center/Dynamic/Extents/Previous
Scale/Window¹ <real time>: P
(za Previous)
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Korak 8

Pomo}u okvira za dijalog Array (slika 4.112)
iskopirajte kvadrat i vertikalnu osnu liniju u
kru`ni niz. 

SLIKA 4.112

Korak 9

Izgled zavr{enog crte`a dat je na slici 4.114.
Kote mo`ete dodati kasnije.

Prvo, izaberite kvadrat i vertikalnu osnu liniju
pored "A" kao na slici 4.113. Za centar niza
izaberite presek pored ''B'' sa slike 4.113. Za
broj kopija unesite {est.

SLIKA 4.113

SLIKA 4.114
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Primer za ve`banje: Angle.dwg

SLIKA 4.115

Svrha

Svrha ovog ve`banja je pravljenje crte`a mnogougaonika, kao na slici 4.115, kori{}enjem komandi
ARRAY i LENGTHEN.

Sistemska pode{avanja

U okviru za dijalog Drawing Units promenite preciznost decimalnih jedinica sa 4 na 2 mesta.
Koristite uobi~ajena pode{avanja za jedinice i granice crte`a: (0,0) za donji levi ugao i (12,9) za 
gornji desni ugao. Uklju~ite slede}e opcije moda OSNAP: Endpoint, Extension, Intersection i Center.

Slojevi

Napravite sloj sa slede}im pode{avanjem:

Name Color Linetype

Object White Continuous

Predlozi za rad

Neka sloj "Object" bude aktivan. Zapo~nite crte` horizontalnom linijom "AB". Koristite komandu
ARRAY da biste kopirali i rotirali liniju "AB" pod uglom od 150 stepeni u smeru kazaljki na satu.
Zatim, produ`ite liniju na odgovaraju}u du`inu komandom LENGTHEN. Ponovite ovaj postupak
za linije "CD", "DE" i "EF". Crte` zavr{ite jednom linijom od ta~ke "F" do ta~ke "A".

Kad god je mogu}e, zamenite celu AutoCAD-ovu komandu odgovaraju}om skra}enicom u
svakom koraku ve`banja. Na primer, koristite "CP" za komandu COPY, "L" za komandu LINE itd.
Potpuni pregled skra}enica komandi nalazi se u tabeli 1.2.
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Korak 1

Nacrtajte liniju "AB" koriste}i polarne koordi-
nate ili metod direktnog uno{enja rastojanja
kao na slici 4.116. Napomena: linija "AB" je
horizontalna.

Command: L (skra}enica za LINE)
Specify first point: 2,1
Specify next point or ŠUndo¹: (Pomerite
kursor nadesno i unesite vrednost od 

3.50)
Specify next point or ŠUndo¹: (Pritisnite
taster ENTER da biste napustili komandu)

Korak 2

Jedan od na~ina za crtanje susednih linija je
pomo}u okvira za dijalog Array, kao na slici
4.117, uz kori{}enje opcije Polar. 

SLIKA 4.117

SLIKA 4.116

Izaberite liniju ''AB'' kao na slici 4.118,
izaberite presek pored ''B'' za centar niza i 
unesite negativnu vrednost za ugao od -150
stepeni. Negativna vrednost za ugao zna~i da
}e linija biti kopirana u smeru kazaljke na
satu.

Rezultat je prikazan na slici 4.118.

SLIKA 4.118
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Korak 3

Sada je potrebno produ`iti rotiranu liniju
"BC" pomo}u komande LENGTHEN za 5.00
jedinica.

Command: LEN (skra}enica za 
LENGTHEN)

Select an object or ŠDelta/Percent/
Total/Dynamic¹: T (za Total)

Specify total length or ŠAngle¹ <1.00>: 
5.00

Select an object to change or ŠUndo¹: 
(Izaberite kraj linije pored "1")

Select an object to change or ŠUndo¹: 
(Pritisnite taster ENTER da iza|ete iz 
komande)

Korak 4

Koristite okvir za dijalog Array kao na slici
4.120 i izvedite operaciju polarnog kopiranja
predmeta. Izaberite liniju ''BC'' kao objekat za
kopiranje, izaberite presek pored ''C'' kao 
centar niza, a za ugao unesite vrednost 
od -55°. Negativna vrednost za ugao zna~i da
}e linija biti kopirana u smeru kazaljke na 
satu.

Rezultat je prikazan na slici 4.119.

SLIKA 4.119

. 

SLIKA 4.120
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Zatim, komandom LENGTHEN skratite liniju
sa 5.00 na 3.00 jedinica (vidite sliku 4.121)

Command: LEN (za LENGTHEN)
Select an object or ŠDelta/Percent/

Total/Dynamic¹: T (za Total)
Specify total length or ŠAngle¹ <5.00>: 

3.00
Select an object to change or ŠUndo¹: 

(Izaberite kraj linije pored "1")
Select an object to change or ŠUndo¹: 

(Pritisnite taster ENTER da biste 
napustili komandu)

Rezultat je prikazan na slici 4.121.

Korak 5

Koristite okvir za dijalog Array kao na slici
4.122 i izvedite operaciju polarnog kopiranja
predmeta. Izaberite liniju ''CD'' kao objekat za
kopiranje, kao na slici 4.123, izaberite presek
pored ''D'' kao centar niza, a za ugao unesite
vrednost od 120°. Pozitivna vrednost za ugao
zna~i da }e linija biti kopirana u pozitivnom
matemati~kom smeru. 

Zatim, komandom LENGTHEN skratite liniju
sa 3.00 na 1.00 jedinica (vidite sliku 4.123).

Command: LEN (za LENGTHEN)
Select an object or ŠDelta/Percent/

Total/Dynamic¹: T (za Total)
Specify total length or ŠAngle¹ <3.00>:

1.00
ŠUndo¹: (Izaberite kraj linije pored "1")
Select an object to change or ŠUndo¹: 

(Pritisnite taster ENTER da iza|ete iz 
komande)

Rezultat je prikazan na slici 4.123.

SLIKA 4.121

SLIKA 4.122

SLIKA 4.123
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Korak 6

Koristite okvir za dijalog Array kao na slici
4.124 i izvedite zavr{nu operaciju polarnog
kopiranja. Izaberite liniju ''DE'' kao objekat za
kopiranje kao na slici 4.125, izaberite presek
pored ''CE' kao centar niza, a za ugao unesite
vrednost od -70°. Negativna vrednost za ugao
zna~i da }e linija biti kopirana u smeru
kazaljke na satu. 

Zatim, komandom LENGTHEN pove}ajte 
liniju sa 1.00 na 7.00 jedinica (videti sliku
4.125).

Command: LEN (za LENGTHEN)
Select an object or
ŠDelta/Percent/Total/Dynamic¹: T

(za Total)
Specify total length or ŠAngle¹ <1.00>: 

7.00
Select an object to change or ŠUndo¹: 

(Izaberite kraj linije pored "1")
Select an object to change or ŠUndo¹: 

(Pritisnite taster ENTER da biste 
napustili komandu)

Rezultat je prikazan na slici 4.125.

SLIKA 4.124

SLIKA 4.125
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Korak 7

Pove`ite linijom krajnje ta~ke "F" i "A", kao
{to je prikazano na slici 4.126.

Command: L (skra}enica za 
LINE)

Specify first point: (Izaberite krajnju 
ta~ku linije pored "F")

Specify next point or ŠUndo¹: (Izaberite 
krajnju ta~ku linije pored "A")

Specify next point or ŠUndo¹: (Pritisnite 
taster ENTER da biste napustili 
komandu)

Kona~an izgled crte`a prikazan je na slici
4.127. Kote mo`ete dodati kasnije.

Ako `elite jo{ primera za ve`banje,
otvorite PDF fajl Priru~nik za ve`banje, 
za Poglavlje 4, koji se nalazi na 
prate}em CD-u.

SLIKA 4.126

SLIKA 4.127
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